
 1

 
Indiana University 
Copenhagen Publishing System 
University Communications — User Manual 
Last Updated: 12/12/2008 
vpurit@indiana.edu 

 
 
Table of Contents 
 
 

• Log in 

• Creating a News Story/Tip Sheet 

• Adding/changing distribution information 

• Inserting an Image  

• Inserting a Video or Slideshow 

• Creating an Expert Source 

• Managing the Media Relations Home Page 

• Managing the Photos & Videos Home Page 

• Loading a Photo  

• Photo Specifications 

• Creating a Newsletter 

• Creating a Newsletter Photo Gallery 

• Distribution 

• Embargoed News Releases 

• Creating a New Group 

• Creating a New Topic 

mailto:vpurit@indiana.edu


• Creating an External News Link 

• Managing News Feeds on External Sites 

• Troubleshooting 

 
Log in 
 
Open Internet Explorer, click on Favorites => PAGR Links => Copenhagen Login 
https://info.iu.edu/admin/  
 
Creating a News Story/Tip Sheet 
 

1. On the left side of the Copenhagen screen, you will see the Navigator Pane. The Navigator Pane 
contains a list of active folders. Select the Pages folder. (It is the default folder, so it may already be 
open.) 

2. Click on the New Page command from the top of the screen. This will open the Page Editor window.  
3. The Page Editor window has several sections. You can jump to each section by clicking on the Jump 

to links at the top of the Page Editor window. 
4. In the General Information section, enter the Page Type.  

a. The Page Type for a news story is News Story.  
b. The Page Type for a tip sheet is Tip sheet.  
c. The Page Type for IU in the News stories is Daily News Brief. 
d. Use Newsletter Story page type for news stories appearing in Newsletters. 

5. Enter the Slug. This is the internal working title for your news story or tip sheet. This is a required field 
(required fields are red).  

6. Enter the Title in the Body table. This is the official, published title for your news story or tip sheet. 
This is a required field.  

7. Click the Save button. You must click Save in order to create a URL for your news story or tip sheet. 
The URL is automatically generated.   

8. After you save, you will see a Pencil Icon in the Title box. Click on the Pencil Icon.  
9. This opens the Composer window. This is where you will enter and edit the body of your news story or 

tip sheet.  
10. Copy your document from Microsoft Word or another word processing program and paste it into the 

Composer text area. The Composer window is a “What You See Is What You Get” editor, meaning 
that whatever styles you apply to the text will be what you see on the Web.    

11. Click the Save button to save the body of your news story or tip sheet.  
12. Click the Close button to go back to the Page Editor window.  
13. Next, enter the Teaser Title in the Teaser table. The teaser title needs to be no more then 40-55 

characters in length. 
14. To create the teaser body, click on the Pencil Icon  in the Teaser Title box.  
15. Enter the teaser body in the Composer window. 
16. Next, position your cursor at the very beginning of the teaser body and insert a thumbnail photo or icon. 

(Please refer to the Inserting an Image section for specific instructions. Standard icons are located in the 
Icons folder within the Navigator Pane). 

17. Click the Save button to save your teaser body and icon. 
18. Click the Close button to go back to the Page Editor window. 
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19. You can create more than one teaser for a news story or tip sheet. To add another teaser, click the + Add 
a new teaser button in the teaser box. 

20. Teaser 1 is the generic teaser that uses a thumbnail image (90px wide).  Teaser 2 uses the medium 
thumbnail image (168px by 168px), and an abbreviated spotlight teaser, and Teaser 3 uses the large 
thumbnail image (168px wide). 

21. Next, scroll down to the Contacts section. 
22. Under Related Persons, select related Faculty Experts (make sure they are published—indicated by a p: 

prefix). To select more than one Faculty Expert, hold down the Ctrl button on your keyboard while 
clicking on the names. 

23. In the External Contacts table you can also enter up to four contacts per news story or tip sheet. The 
contacts are labeled External Contacts #1 through #4.  

24. In the first field of External Contacts #1, select the Type of contact. Your options are Contact 
Information, Media Contacts, or Secretarial Contact. 

25. Enter the Name of the contact. Use the contact’s full name in this field.  
26. Enter the Title of the contact.  
27. Enter the Phone, Fax, and E-mail Address information for the contact.  
28. Click on the top link directly after and to the right of the external contacts table to go to the top of the 

Page Editor window. Click on the Save button to save your new story or tip sheet. 
29. In the Keywords & Links section, enter search keywords in the Keywords text area. Keywords will 

help drive traffic to the news release based on search engine results (such as Google). 
30. In the Related Links table, enter up to six related external Web sites. 
31. In the Threading area, select additional images you want to be included to the right of the news release.   
32. In the Related Groups section, check all related groups (IU Schools, Departments, Institutes, etc.). 
33. In the Related Topics section, check all related topics. 
34. Click on the top link directly after and to the right of the Related Topics table to go to the top of the 

Page Editor window. Click on the Save button to save your new story or tip sheet. 
35. Finally, click the Check-in button. In the Change Document Status section, select Proposed in the 

drop-down list to submit the news story or tip sheet for editing. You can also send the news story or tip 
sheet for copy editing or review to a specific editor by selecting a name from the Check Out To drop-
down list in the Options section. This will send an e-mail to the editor selected once you save and close 
the document. If you want to receive a copy of this e-mail, select Yes to the question below the Check 
Out To drop-down list (No is the default option). In the text box below, you can enter an optional 
message for your copy editor or reviewer. 

36. Click on the Save button. The window closes automatically. You have now created a news story or tip 
sheet. 

 
 
Adding/changing distribution information 
 

1. On the left side of the Copenhagen screen, you will see the Navigator Pane. The Navigator Pane 
contains a list of active folders. Select the Pages folder. (It is the default folder, so it may already be 
open.) 

2. Click on the New task button at the top of the right side of the Copenhagen screen. The Document 
Distribution Information window will open. You can edit existing Distribution Tasks by clicking on 
the task’s link (in blue) on the Distribution Task Calendar in the Tasks section. 

1. If no Distribution Task exists, you can add a new Distribution Task by clicking on the  Add a 
Task button above the Distribution Task Calendar. 

2. In the Add a Distribution Task window, enter the task’s Name/Slug (add an e-mail:  prefix for e-mail 
tasks). 

3. Enter the Date the task was created in the date field of the Add a Task section.  
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4. Select Indiana University Media Relations from the Assign To drop-down menu in the Add a Task 
section. 

5. In the Task Information section, check all relevant Standard Email Distribution Lists. 
6. Click the Save button in the top right corner of the window to save the task. 
7. Click the Close button to close the Add a Distribution Task window. 
8. Click the Close button in the top right corner of the Document Distribution Information window. 



Inserting an Image 
 
This new version of Copenhagen enables you to publish images with your news story. You can insert photos as 
you create news stories, or you can enter them when you are editing news stories.  
 

1. To open a news release, double-click on the desired news release listed on the right side of the 
Copenhagen screen. This will open the Page Editor window. 

2. In the Headline field in the Body table, select the Pencil Icon .  This will open the Composer 
window.  

3. In the body of your news release, move your cursor to the point where you want to insert the image. 
From the Insert menu, select the + image… command. 

4. The Image Chooser dialog box will open. 
a. In the Image Finder area, click on various items in the Category box to review your image 

choices. All available images are loaded into the Image Database. 
b. Small Thumbnail images have a [thumb], medium thumbnails have a [vid] suffix. Web version 

of image does not have a suffix. Only published images show up in the image browser. If an 
image does not show up, change its status to published. 

c. In the Text area, enter Caption and Title information for your image. 
d. In the Dimensions area, enter the height and width of the image. If Preserve Aspect Ratio is 

selected, your image will automatically be scaled to the correct proportions. If you want vertical 
or horizontal padding around the image, fill in the desired pixel amount in the V. Space and H. 
Space boxes. 

e. In the Alignment area, choose whether you want your image to align to the left, center, or right 
of your news story body. Left is the recommended default. 

f. In the Layout area, choose whether you want your image to appear with text wrapping around it 
(In Line) or without text wrapping (Standalone).  

5. Click the OK button to add your image to the news release. 
6. The image alignment will not preview correctly in the Composer window. To preview the news release, 

Save and Close the Composer window, then Save and Check In the news release. Then click on the 
Check-In button at the top of the Copenhagen screen.  

 
Note to editors: To find all Proposed pages, in the Show menu of the Copenhagen screen, click on Checked In 
or Out in the first drop-down list, Proposed in the second drop-down list, Any Page Type in the third drop-
down list, and then click the Go button. 
 
 
Creating an Expert Source 
 

1. In the Navigator Pane on the left side of the Copenhagen screen, select the Persons folder. The 
Persons folder is where all the expert sources are stored.  

2. Click on the New Person link at the top of the screen. This will open the Page Editor window.  
3. In the Name, Title and Body section, enter information about the expert. The Person Type, First 

Name, and Last Name are required (required fields are red).  
4. In the Contact Information section, enter the expert’s contact information, including home and work 

addresses, phone number(s) and e-mail address(es). You are required to provide at least a work phone 
number and e-mail address for the faculty expert. 

5. In the Educational Background section, enter the expert’s educational background information.  
6. The Contacts section is where you enter information about external contacts related to the expert 

source. For example, if there is a media relations writer who handles contact with this expert, enter the 
writer’s information here.  
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7. In the Keywords & Links section, enter keywords about the expert’s research interests. Keywords will 
help reporters search for the expert. The keywords will be labeled as Interests on the expert page. You 
may also enter Related Links in the Related Links table. 

8. The Publication Information section is where you enter information about where the expert will appear 
on the Web site and in which presentation templates.  

9. The expert can also be associated with groups and topics. You enter this information in the Related 
Groups area and the Area of Expertise/Related Topics area. Enter the title the expert holds for each 
group or enter the titles in the Primary Title field. Titles need to be separated by commas.  

10. Click Save to save the information you’ve entered.  
11. Click Contact to go to the Contact dialog box and enter the expert’s contact information.  
12. You can add an expert’s photo in either the Body section or the Teaser section. To add a photo, use the 

Body or Teaser editor boxes (select the Pencil Icon) and use the + image… command from the Insert 
menu.  Teaser 1 is the expert source’s generic teaser and Teaser 2 is the expert source’s abbreviated 
biography. 

13. The Image Chooser dialog box opens. 
a. In the Preview area, review your image choices. All available images are loaded into the Image 

Database. Images are organized by topics. 
b. In the Text area, you enter caption and title information for your image. 
c. In the Dimensions area, you enter the height and width of the image. If Preserve Aspect Ratio 

is selected, your image will automatically be scaled to the correct proportions. If you want 
vertical or horizontal padding around the image, fill in the amount in the V. Space and H. Space 
boxes. 

d. In the Alignment area, choose whether you want your image to align to the left, center, or right 
of your news story body.  

e. In the Layout area, choose whether you want your image to appear with text wrapping around it 
(In Line) or without text wrapping (Standalone). 

14. Click Save to save your expert. Click Close to exit. Your expert will appear in the list of published 
experts.  

 
 
Managing the Media Relations Home Page 
 

1. From the Pages folder, look for a page with the URL ‘5959.html.’ Double-click on the page to edit.  
2. The Page Editor window opens.  
3. Scroll down to the Threading area. This is where you select the stories that will appear on the home 

page. There are ten channels.  
a. Channel 1 is where you select a news story to be featured as Research News. You can select one 

story for publication here.  
b. Channel 2 is where you select an image for a Featured Podcast. You can select one image here.  
c. Channel 3 is where you select the topics that you want displayed on the homepage. You can 

select up to 11 topics. 
d. Channel 4 is where you display the top news story. You can select one story here. 
e. Channel 5 is where you can display three Recent News Stories to be displayed with medium 

thumbnail. You can select three news stories here. 
f. Channel 6 is where you can select three Recent News Stories to be displayed with the teaser 

image. You can select up to three stories here. 
g. Channel 7 is where you can select an image for a featured Photo Gallery. You can select one 

image here. 
h. Channel 8 is where you can select an image for a Video News story. You can select one image 

here. 
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i. Channel 9 is where you can select a news story about a campus event. You can select one story 
here. 

j. Channel 10 is where you can select a campus news story. You can select one news story here. 
4. In each of the channels, you can choose from a drop-down list of news stories. Green indicates a news 

story in draft or proposed form. Black indicates a published story. Red indicates a news story that is 
embargoed. You can choose a draft or embargoed news story in these channels, and once the status 
changes to published, the news story will show up on the home page automatically.  

5. Once you have made your selections, change the status of the page to proposed, find page ‘/5959.html’ 
and click on the View button. If the homepage looks how you intended, change status to published. 

 
Managing the Photos & Videos Home Page 
 

1. From the Pages folder, look for a page with the URL ‘/2239.html.’ Double-click on the page to edit.  
2. The Page Editor window opens.  
3. Scroll down to the Threading area. This is where you select the photos and videos that will appear 

on this page. There are two channels.  
a. Channel 1 is where images are displayed. 
b. Channel 2 is where videos and slideshows are displayed. 

4. In each of the channels, you can choose from a drop-down list of assets. Green indicates an asset in 
draft or proposed form. Black indicates a published asset. Red indicates an asset that is embargoed. 
You can choose a draft or embargoed asset in these channels, and once the status changes to 
published, the asset will show up on the page automatically.  

 
 
Loading a Photo 
 

1. Choose the Assets folder from the left Navigator pane. 
2. At the top of the page, you will see the command New Asset. Select New Asset.  
3. The New Image dialog box opens.  
4. Choose Image Type. Image asset type is shared among all the publishers and Featured Photo is used 

by University Communications staff. Choose Featured Photo asset type for photos that may be featured 
on the homepage and other places throughout IU News Room.   

5. Enter the required information: Slug, Title, and Folder. Select Save to save this information.  
6. In Files area, you need to enter the information about the image. You have four options—Web Ready 

Image, Teaser Image (known as a thumbnail image), Medium thumbnail, and/or Print Ready Image. 
You should make the same photo available in all four formats when possible, but it is recommended that 
at least small Thumbnail and Web version are uploaded.   

7. To upload the photo, go to the Upload a File area. Select Browse… to obtain the image.  
8. Once you have uploaded the image, you can fill in options for alignment, padding, ALT text, and a 

caption.  
9. Associate the photo with all the relevant Related Groups and Topics. This will add the photo to the 

topical photo galleries. 
10. Select Save to save this information.  

 
Photo Specifications 
 
The following photo specifications are recommended: 
Web Ready Image (vertical and horizontal): 308 pixels wide (max), 72 dpi 
Medium thumbnail/Video image 168 pixels x 168 pixels, 72 dpi. 
Teaser Image (Thumbnail): 90 pixels (required) x 90 pixels (recommended), 72 dpi. 



Print Ready Image: 900 pixels x 1500 pixels (3 in. x 5 in.), 300 dpi minimum (recommended). JPG format only. 
 
Loading a Video or Slideshow 
 

1. Choose the Assets folder from the left Navigator pane. 
2. At the top of the page, you will see the command New Asset. Select New Asset.  
3. The New Image dialog box opens.  
4. Enter the required information: Slug, Title, and Folder. Select Save to save this information.  
5. In the Files area, you need to enter the information about the video or slideshow. First, upload a photo as 

a Medium Thumbnail or Video Image and small Thumbnail. Web Version is optional. 
6. To upload a photo, go to the Upload a File area. Select Browse… to obtain the image. 
7. Once you have uploaded the image, you can fill in options for alignment, padding, ALT text, and a 

caption.  
8. Select Save to save this information.  
9. Next, find the Video or Slideshow area. 
10. If this is a slideshow or video that will be displayed inside the IU News Room site, enter the URL into 

the URL for inline Video or Slideshow field.  If this is a video that will be displayed externally, enter 
the URL in the URL for video download field. 

11. Next select the Format (Flash Video or Flash Slideshow). 
12. Leave the slideshow width and height as is. 
13. Next enter a transcript URL. You can do this one of two ways:  

a. If the transcript is located on another Web site, enter the URL in the Enter Transcript URL 
field.   

b. If the transcript is not located on another Web site, enter ?s=body in the Enter Transcript 
URL field. Then, scroll up to the Body area and click Edit. Enter the transcript in the body 
editor that appears and select Save to save the transcript and then Close to exit the Body editor. 

14. Associate the asset with all the relevant Related Groups and Topics. This will add the photo to the 
topical photo galleries. 

15. Select Save to save this information. 
  

 

Distribution 
 

1. In order to distribute a news release, log in to Copenhagen as the iuinfo user. 
2. Click on  My Copenhagen in the Navigator Pane to preview distribution tasks assigned to the iuinfo 

(Indiana University Media Relations) user.  
3. In the My Copenhagen window you will see all the distributions (completed and pending) for this 

account. 
4. Click on a blue task (blue indicates a tentative task) to perform the distribution.  
5. In the E-mail Distribution Task Information window click  Distribute to open the E-mail 

Document window. 
6. Optional: Click on the Bcc Lists: link to preview the selected Standard E-mail Distribution Lists. 
7. Optional: Click Options to expand the options section.  

a. The default is to send the message immediately. If you wish to schedule the message to be sent 
out at a later time, enter the send time/date. 

b. Select e-mail format. Use either Rich Media: graphics and text to send a hybrid HTML/text e-
mail, or Plain text to send a text only version of the e-mail. 

c. The Attach Documents As:  option allows you to send full documents, or Teasers only. 
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i. Use Caches When Possible will send the version of the page that you can see on your 
Web site. 

ii. Skip Unpublished Content will ignore the releases whose status is not Published or 
Archived. 

Note: Unpublished content (drafts) cannot currently be e-mailed. Please publish a news release before sending 
it out. 

 
8. Click the send button to send the news release. 
9. You can now close all the windows. 
10. Go to My Copenhagen and click  refresh  
11. You will now see that the task is either green (confirmed, waiting for scheduled distribution), red (in 

process of being sent out), or grayed out (completed). By clicking on the task you can see historical data 
on when the distribution occurred, how many recipients it was sent out to, which lists, etc. 

 
In case of fax and post mail distribution, make sure to  Mark as Completed in the Distribution Task 
Information window. Do not use this feature for e-mail distribution. 
 
 

Embargoed News Releases 
 
Dealing with embargoed news releases requires extra care, because if something is posted, even for a very short 
time, it is likely to get picked up my Google or another search engine, and the contents may be made public 
immediately. 
 
If you must publish an embargoed news release before the release date has arrived, you must carefully follow 
this procedure: 
 
1. Version the page 

Select the news release. Once highlighted, and click the Version button:  
This saves all content and settings associated with the news release in its current state, allowing you to revert to 
this state once you are finished making your changes and/or printing a copy. 
 
Make a note of the time that you create this backup version.  This will make it easier to determine which version 
to restore later in this process. 
 
2. Disallow from all “Public Copenhagen Web Sites” 
 
Edit the news release, scroll down to the section labeled Public Copenhagen Web Sites. Make sure that the 
Available on All Sites checkbox is unchecked and that all other individual web site Disallow boxes are 
checked, i.e. check the box next to “School of Law” to make sure that this news released, when it’s published 
temporarily, won’t be made available on the law school web site. 
 
3. Edit and uncheck all Group and Topic references (ex. Kelley School of Business, Maurer School of Law) 
 
Scroll down to the sections labeled Related Groups and Related Topics.  Carefully uncheck all boxes that are 
checked, effectively disassociating the news release from all groups and topics.  You may need to expand a 
group or topic in order to see all of the sub items beneath the top level.  Click on the right-pointing arrow  to 
expand an item. 
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4. Publish 
 
Publish your news release as usual.  Click Check-In, change the New Status to “Published”, and click the Save 
button. 
 
5. Distribute (see distribution section) 
 
Distribute the news release to yourself or anyone who might need to see this release early. 
 
6. Unpublish ( mark delete XML cache ) 
 
Edit the news release again and click Check In.  Set the New Status back to “Embargoed”.  In the Options 
section (Step 3) check the Delete XML Data Cache checkbox.  This will clear the new release’s XML data, 
removing all traces of the temporarily published news release from the live web server.  
 
7. Restore to the versioned page 

Highlight the news release and click the Info button:  

This will take you to the news release’s Document Information.  Scroll down to the Edit History section to see 
all of the saved instances of this news release displayed in order by the date and time the edit process was 
completed.  Locate the edit you just versioned in the list and click the  Restore button in the Action column.  
This will return all details of the news release to those saved at the time the document was versioned, including 
the group associations and the lack of disallow options. 
 
8. Save and Check-In the news release 
 
Click Save to save the restored version of the news release and click Check-In.  Set the New Status back to 
“Embargoed” and click Save. 

 
Printing Without Publishing 
 
You also have the option of printing a news release without first publishing.  Simply highlight the news 

release and click the Print button:  
Select the version you would like to print, most likely Current Working Draft, and a template and click 

the Print button:  
 
If asked if you would like to display nonsecure items, click the Yes button.  This will allow header graphics 
to be displayed in the document. 
 
If the header graphics do not appear in your printout, you must change the settings in your web browser to 
allow the printing of background colors and images.  In Internet Explorer this option is found in the 
Internet Options on the Advanced tab. 
 

 
Creating a New Group 
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1. In the Navigator Pane of the Copenhagen screen, click on the Groups folder. 
2. Select the New Group command from the top of the screen. This will open the Page Editor window.  
3. In the General Information section, select a Group Type from the drop-down list. Currently available 

group types are: 
a. Campus 
b. Department 
c. Program 
d. School 
e. Administrative Office 

4. Enter the group name in the Name field.   
5. Click on the Save button to save the group. 
6. Click on the Relations button. 
7. In the Group Composer window, select one Parent in the Group Structure section (select Groups to 

be the parent if the group you are creating is a top level category). 
8. Select all relevant Related Groups in the Group Structure section. 
9. Scroll down to the Related Topics section and select all relevant Related Topics. 
10. Click on the top link directly after and to the right of the Related Topics section to go to the top of the 

Group Composer window.   
11. Click on the Save button. 
12. Click on the Check-In button. 
13. In the Change Document Status section, select Published in the drop-down list. 
14. Click on the Save button. The Page Editor window will automatically close. 

 
 
Creating a New Topic 
 

1. In the Navigator Pane of the Copenhagen screen, click on the Topics folder. 
2. Select the New Topic command from the top of the screen. This will open the Page Editor window.  
3. In the General Information section, make sure that the Topic Type is Topic.  
4. Enter the topic slug in the Slug field.  
5. Enter the topic title in the Title field in the Body table.   
6. Click on the Save button to save the topic. 
7. Scroll down to the Topics Structure and Related Groups section. 
8. In the Topics Structure and Related Groups section, select one Parent Topic (select Topics to be the 

parent if the topic you are creating is a top level topic). 
9. Select all relevant Related Topics in the Topics Structure and Related Groups section. 
10. Scroll up to the Related Groups section and select all relevant Related Groups. 
11. Click on the top link directly after and to the right of the Related Groups section to go to the top of the 

Page Editor window.   
12. Click on the Save button. 
13. Click on the Check-In button. 
14. In the Change Document Status section, select Published in the drop-down list. 
15. Click on the Save button. The Page Editor window will automatically close. 

 
Creating an External News Link 
 

1. On the left side of the Copenhagen screen, you will see the Navigator Pane. The Navigator Pane 
contains a list of active folders. Select the Pages folder. (It is the default folder, so it may already be 
open.) 

2. Click on the New Page  command from the top of the screen. This will open the Page Editor window.  



3. In the General Information section, leave  Page Type as News release. 
4. Enter the Slug. This is the internal working title for your external news link. This is a required field 

(required fields are red).  
5. Enter the Headline in the Body table. This is the official, published title for external news link. 
6. Click the Save button. You must click Save in order to create a URL for your external news link. The 

URL is automatically generated.   
7. After you save, enter the “Teaser Head:”. It should not exceed 40-55 characters. There is a counter 

available at the end of the form field that displays the total character count. Teaser Headline is what 
will actually display as a link on the gateway and other external pages. If the total character count 
exceeds 55 it may not fit on two lines on the Gateway page (www.indiana.edu). 

8. Click the Pencil Icon  next to the Teaser Head box.  
9. This opens the Composer window. This is where you will enter and edit the teaser copy for your 

external news link.  
10. Next, position your cursor at the beginning of the teaser body and insert a thumbnail photo or icon. 

(Please refer to the Inserting an Image section for specific instructions. Standard icons are located in the 
Icons folder within the Navigator Pane). 

11. Click the Save button to save the teaser copy for your external news link.  
12. Click the Close button to go back to the Page Editor window.  
13. Click the Save button. 
14. Delete the automatically generated URL above the Teaser table and insert the URL to the Web site 

where the external news link should go.   
15. Click the Save button. 
16. If you would like your external news link to be listed on the topics pages, scroll down the Page Editor 

window and check all appropriate boxes in the Related Topics and Related Groups sections. 
17. Click the Save button. 
18. Finally, click the Check-in button. In the Check-In or Check-Out to Someone Else section, select 

Proposed in the drop-down list to submit the external news link for editing. You can also send the 
external news link for review to a specific editor by selecting a name from the Check Out To drop-
down list that appears after you select Proposed from the drop-down list. This will send an e-mail to the 
editor selected once you save and close the document. If you want to receive a copy of this e-mail, select 
Yes to the question Send a copy of the notification e-mail to you? underneath the Check Out To 
drop-down list (Yes is the default option). In the text box with the header Additional Instructions, you 
can enter an optional message to your copy editor or reviewer. 

19. Click on the Save button. The window closes automatically. You have now created an external news 
link. 

20. Note: Only published documents can be distributed to external clients. Please refer to Managing News 
Feeds for instructions on distributing the newly created external link to other external Web sites 
(www.indiana.edu, www.iusb.edu, etc.). 

 

Managing News Feeds on External Sites 

1. Log in under the clientMgr account. 
2. In the Navigator Pane of the Copenhagen screen, click on the Distribution folder. 
3. Click on the Browse External Clients link. 
4. In the External Client window, click Edit   
5. In the Description field, you will find contact information and guidelines for news feed distribution to 

external clients. 
6. Under the Threading section, you will find one or more Channels. Each Channel is a separate news 

feed. 
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7. Select News Releases that will be distributed to each channel. (Only Published documents p: will be 
distributed.) 

8. Click Save. 
9. Click Close.   

 
 
Troubleshooting 
 
 
Additional Help: You can see onscreen help by clicking the   help icon where available. 
 
Copy/paste: 
 
• If you are working on a home computer, you will need to add the following parameter to your Java Plug-in. 

Plug-in. This can be set under: 
Start => Control Panel => Java Plug-in => Advanced => Java Runtime Parameters field: 
 -Djava.security.policy=http://newsinfo.iu.edu/policy/mrps.policy 

• If the copy/paste functionality stops working, try to copy and paste some text from the java composer 
window to the same java composer window. On your next try, pasting from your browser or MS Word to 
the Java composer will work again.  
 

Mixed Content Warning 
• If you do not wish to see the mixed content alert in Internet Explorer, you must enable mixed content 

by clicking Tools => Internet Options => Security => Custom Level => and under Display Mixed 
Content (in middle of the list under the Miscellaneous heading) click Enable. 

 
Unable to send a draft for review 

• The current version of Copenhagen does not allow you to e-mail documents that have never been 
published. Please publish the document before e-mailing it for review. Once you e-mail the document, 
change its status back to draft. Make sure to check Delete XML Data Cache to remove the cached 
version of the page from the public site to prevent it from being accessed by the public. 
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